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Welcome to Organic Art Deluxe!

Organic Art Deluxe is both a powerful framework for you to design 3D living 
sculptures, and an infinitely varying display of leading-edge computer graphics.    
We hope you enjoy using it as much as we do.

This help file will guide you through getting Organic Art Deluxe up and running on
your computer, how to personalise your Organic Art preferences, and using the 
Designer application to create your own scenes.

For more information, other Computer Artworks images and technology see our 
web site on "http://www.artworks.co.uk".
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Enabling 3D Hardware Acceleration

By default when Organic Art is installed, 3D hardware acceleration is disabled - all
3D rendering will be done using software only.    The reason for this is that drivers 
for 3D accelerator cards are not always 100% reliable, and driver problems could 
cause your machine to lock up when you run Organic Art.

If you have a 3D accelerator, once Organic Art is installed and working fine in 
software, you can try enabling 3D acceleration and test it out.    For the screen 
saver, the the settings are in its configuration dialog.    You can confirm that 
hardware acceleration is being used by enabling the caption bar.    In the Designer 
select "Use Hardware Acceleration" from the Options menu.

If the machine does crash, either revert to using software rendering, or obtain an 
updated driver for your 3D card see also the Troubleshooting section of this help 
file.    Otherwise enjoy Organic Art Deluxe running faster and looking better (you 
may also want to change the default screen saver display mode to a higher 
resolution and 32-bit colour if supported).    The scenes under Elastic and 
OADeluxe make the best use of 3D hardware.



Troubleshooting

For technical support and a list of 3D card manufacturer's websites, please see the 
Mindscape Help file, in the Organic Art Deluxe group under the Windows Start 
menu.

· Crashes, lockups, screen corruption, meshes/textures looking wrong or not 
appearing, etc. when 3D hardware acceleration is enabled.    Upgrading the 
driver for the 3D card will often fix the problem.

· Runs slowly on a 3D accelerator.    Make sure hardware acceleration is enabled -
see Enabling 3D Hardware Acceleration.

· Installer gives an error regarding self-registering components, some backdrops 
don't work, Elasticity has no effect.    This is a problem on Windows 95 - try 
installing Internet Explorer 4 or above, Windows 98 or Windows 2000 and re-
install Organic Art.

· Doesn't run on Windows NT 4.    Unfortunately Organic Art does not support 
NT 4, as it only has DirectX 3, whereas Organic Art requires DX6 or above.    
DX cannot be upgraded by application installers on NT, only by Service Packs.

· Problems on Windows 2000.      We have tested Organic Art on Windows 2000 
Beta 3, which is    the latest release at the time of going to master, and no 
problems have been found.    However, we cannot guarantee there will not be 
problems with future versions - please check with technical support for the 
latest info.    If you are using 3D hardware acceleration, please try upgrading the
display driver first.

· Screen flashes white on scenes with motion blur on the Matrox G200.    This is a
driver bug on the G200 - try a newer driver.

· Backdrops look blurry on the Voodoo.    The Voodoo 1, 2 & 3 are limited to 
256x256 resolution for the backdrops.    Other cards don't have this restriction 
and the backdrops will look sharper.

· Screen saver doesn't start, takes a very long time to start, or objects don't move 
smoothly.    There may be a clash with the CDROM drive - try unchecking 
"Play CD audio" if you have it enabled.

· "Play CD audio" doesn't play when the screen saver starts.    If another CD 
player applet is running (even if it is Stopped) it will have exclusive control of 
the CD drive, preventing this feature from working.    Otherwise, make sure 
volume is up, sound isn't muted and that Windows CD player can play the CD 



ok.
· Objects don't move smoothly in screen saver and stutter/pause frequently, or 

screen saver runs at a much lower frame rate than the Designer.    This is most 
likely caused by an application currently running on the desktop, or a traybar 
applet.    Either they are using excess CPU even when inactive, or they are 
broadcasting system messages periodically, causing the screen saver to pause 
briefly.

· Scenes run more slowly after screen saver has been running for extended 
periods of time.    This appears to be a DirectX RM problem, and no fix is 
available at this time.

· Scenes under OADeluxe or using Elasticity run slowly.    For these more 
complex scenes and special effects we recommend at least a Pentium II 300 and
a 3D accelerator for best results.



Screen Saver Configuration

Accessing the Configuration Dialog
The screen saver configuration dialog can be accessed by starting the Windows 
Control Panel and launching Display Properties (or right click anywhere on the 
desktop and select Properties).

Then go to the Screen Saver tab (there may be a slight delay while Organic Art 
starts to run in the preview window).    Ensure "Organic Art Deluxe" is selected 
from the list of screen savers, and hit "Settings".

The screen saver options then have their own help which can be accessed by 
clicking on the "?" icon in the corner of the window.    The cursor will change to 
show a "?" also, then click on a control to see its popup help.



Designer Quick Start

Viewing Preset Scenes
From the Scenes Menu, choose scene names from the pop-up sub-menus which 
appear. 

Creating Your Own Scene - a Walk-through
· From the File Menu, choose "New Scene".
· Click on the Mutate Button to get a randomised scene.    Keep going until you 

get something you quite like.    Use the Lighting Menu and Tool Window 
controls to adjust things until you are happy.

· From the File Menu, choose "Save Scene As..." and give your scene a name.
· That's it.    Your scene will now be in the Scenes Menu - there is a new submenu

using your Windows user name, and the new scene under that.    It will also 
automatically be added to the screen saver playlist.



File Menu

New Scene
This creates a new, blank scene, with a small spinning shape in the centre as a 
place-holder.    Work from here with the menus and tool window controls, or use 
the Mutate Button to randomize the scene. 

Save Scene As...
When you have created a new scene, or altered an existing one, this will store the 
scene on your hard disk.    Either keep the same name to overwrite the previous 
version, or use a new name to create a separate scene.    Newly created scenes will 
automatically be added to the Scenes Menu, and the screen saver playlist.

Scenes are prefixed with your Windows user name to group them together.    Note 
this means you cannot overwrite built-in scenes, but you can modify them, save 
them under a new name, and use the screen saver playlist if you wish to de-activate
the original version.

Scene definitions use very little space on your disk - they are around 2k each, as 
they simply record the choices you have made for the various settings.

Revert To Saved
Use this if you have modified a scene, and wish to revert it to its previous settings 
(by reloading it from the last saved version).

Delete Current Scene
Deletes the current scene, removing it permanently.    Use the screen saver playlist 
if you want to de-activate a scene but not delete it completely.
Note you can only permanently delete your own scenes.

Save Image As...
Saves the image in the window to disk as a .BMP file (the default location is the 
"Images" directory under where you installed Organic Art).
The image is not copied from the window, but the scene is re-rendered in memory, 
using the same number of colours as your desktop mode but at much higher 
resolution.    The image is then anti-aliased down to the size you specify in the save
options dialog.



Note that images with Trails on cannot be saved in this way (due to the way parts 
of the graphics system work, the Trails are not stored anywhere), and similarly 
motion blur will not be visible in saved images.

Tip: You can interrupt saving by hitting the Esc key.
Tip: You can capture trails images by copying the current window contents to the 
clipboard by hitting Alt and "Prt Sc" on the keyboard, then pasting the clipboard 
image into a paint package.
Advanced Tip: You can use saved images, or other graphics, as new backdrops or 
textures, by converting them to GIF (256 colours) or PNG (24-bit) format, then 
placing them in the Backdrop or Textures folders (under the Organic Art install 
directory).    The width and height shoud be a power of 2 (..., 64, 128, 256,...), e.g. 
512x512 for backdrops and 256x256 or 128x128 for textures.    Other sizes will 
work but take longer to load.

Save As Wallpaper
Saves the image into your Windows directory (as Organic.bmp) and automatically 
sets it to be your wallpaper.

Exit
Exits the Organic Art Designer.    If you have modified the current scene, but not 
saved it, it will be automatically stored and reloaded when you next start Organic 
Art.    You can change this behaviour from the Advanced Options dialog box.



Lighting Menu

This menu allows you to choose from a set of lighting models.    Using different 
lighting can give a variety of different looks to your scene.    Note that using the 
coloured lighting models requires more processing power, and will make the scene 
run a little less quickly.

The lighting models are:

"Default"
Moderate ambient lighting, with a bright white light at the top right.    A good 
standard model.

"BBC style"
As per Default, but with a half-brightness fill-in overhead.    Gives good depth, 
with objects looking solidly 3D.    See "Stills/Snakes"

"Metallic"
Low ambient, with bright lights top right and left-centre.    This is a special lighting
model which customises the inform material properties to appear metallic (by 
making the shading round objects fade to black more rapidly).    Very rich look.    
See "Talismans/Silver".

"Multi-coloured RGB"
Red, green and blue rotating lights, coming from all directions.    Using with fast 
animated scenes gives a "disco lights" effect (Geometric/Asteroid Dance).    Can be
more subtle if used with dark shapes (Geometric/Geometry, Dark/Dark 'Pod).
Using with Trails is interesting, making colours change over time (Dark/Deep Sea, 
Dark/Sea Worm).
Coloured lights also interact with textures containing the same primary colour, 
giving a "glow" effect (see Single/Heart).

"Multi-coloured YCM"
Like RGB, but using Yellow, Cyan and Magenta lights.    See "Mono/Hypno".

"Purple-Green"
Another rotating coloured-light model, using two lights of (surprise) purple and 
green.    Gives a more subtle effect, see "Dark/Triangles" and "Faces/Black Abyss".

"Uplit"



A single up-lighter.    Gives a rather strange, surreal effect.    See "Weird/EyeBall" 
and "Faces/Abyss".

"Top down"
A directional light top-right, good for using with shadows.    See "Titles/Demo 
Titles".

"Top and left"
As top down, but with a left-centre fill in to brighten it up.    See "Titles/New 
Titles".



The Generator Menu

This selects the form and motion to use in the scene.    The best way to explore this 
setting is to select two simple shapes as informs, set Ribs and Branches quite low, 
and try out different Generators to see what they do.
Alternatively, you can open Mutate Options, and select just the Generator by itself,
then use the Mutate button to cycle randomly through them.



Scenes Menu

The Scenes Menu allows you to display each of the scenes in Organic Art.    Any 
scenes you create yourself will be automatically added to this menu, using your 
Windows username as a sub-menu.

This menu is arranged as a cascade of sub-menus, so the large number of scenes 
can be grouped together (and so the menu doesn't go right off the bottom of the 
screen!).    A forward slash "/" or underscore "_" in a scene name separates it into a 
new sub-menu.    The built-in scenes only use one level deep, but you can have 
more, e.g. "User/My New Ones/Squirly Thing", would have two sub-menus.



Interface Menu

Hide/Show Tool Window
This stows away and restores the Tool Window, allowing you to run the scene 
using the full area of the Designer's window.

Hide/Show Status Bar
This stows away and restores the Status Bar.



Help Menu

Contents/Search for Help on…
Opens the on-line help (or hit F1).

About
Brings up the about box, showing the version number of Organic Art and other 
system information.



Saving Options

This box contains settings for when you save an image from Organic Art using File
Save Image As.

When you save an image from Organic Art, it does not save what you see on the 
screen, but re-renders the image at high resolution (2048x2048) using the current 
desktop colour depth, and with other image quality options turned on.    This 
rendered frame is then resampled down to the size you set in this dialog, which 
results in very good image quality.
Note that this process uses quite a lot of RAM (over 24MB) and so can take some 
time, particularly on complex scenes.
Wallpaper is always saved at the current desktop size.

Tip: you can also copy the contents of the current window to the clipboard by 
hitting Alt-Prc Sc, then paste the image into a paint package.
Tip: for highest quality results, set the desktop to a 24-bit or 32-bit before saving.



Mutate Options

This box controls which elements of a scene are randomised by hitting the Mutate 
button.    Try checking several of them to find an interesting starting point, then 
switch off mutation for each element you are happy with, re-mutating the rest.

Tip: This dialog can also be accessed by right clicking on the Mutate button itself.



Advanced Options

Unsaved Scenes
If you make changes to a scene, a "*" is appended to its name in the title bar.    
These options control what happens if you try to exit without first saving the 
current scene:

· Reload it next time - the scene is automatically stored and reloaded when you 
next start the Designer.    To remove this "Unsaved Scene", use "Delete Current 
Scene" in the File menu, or use "Save Scene As" to save it properly.

· Ask whether to save it - You are asked whether you want to save the scene 
before quitting (using the normal "Save Scene As" dialog).

· Discard any changes - You must explicitly save any scenes you wish to keep 
before quitting, or the changes will be lost.

Note that only the current scene is considered - any changes made to other scenes 
you have switched away from are always discarded if you do not save them before 
quitting.

Status Bar Style
Choose your preference for the Status Bar's progress meter.



The Tool Window

Mutate Button
This randomises each setting automatically.    You can control which settings are 
mutated by using the Mutate Options dialog box.    This is in the Options menu, or 
you can quickly access it by right-clicking on the button itself.

Tip: Initially, mutate most of the scene settings to get something completely new, 
then gradually un-check settings you are happy with.    Then use the individual 
controls to refine each setting to be exactly as you want it.

The Mutate Button can be a source of great variation, taking you to starting points 
you might never have discovered otherwise.
Some mutations can be produced which are overly complex, if an advanced 
generator and complex meshes are selected at random, plus Ribs and Branches are 
set high.    If the scene appears to be taking a very long time to render, just hit 
Mutate again to choose a new configuration.

Restart Button
This button "fast forwards" the scene, jumping to a different position (like Infinite 
Speed, but just once).    Use this button with animated or Trails scenes to jump 
around to different variations it can reach.    It will also reset Elastic Meshes to their
initial shape.

Tip: you can right-click this button to refresh/redraw the window.

Backdrop
Pick a backdrop from this dropdown list (click on it to make the list appear).    You 
can use cursor keys to scroll through the list, and right-clicks to randomise the 
setting (see General Interface Tips).

Motion Blur
This effect leaves fading trails behind moving objects.    At low settings the effect 
is subtle and may only be visible if the objects are moving quickly.    At very high 
settings the trails may not be fully erased, and leave a faint image behind; this is 
affected by the background (less likely to happen on plain colours, particularly 
black), plus the accuracy of the 3D card's alpha blending (a 32-bit mode will look 



much better than a 16-bit mode).

Note: This effect is only available when using a 3D accelerator which supports the 
necessary alpha-blending modes.    If the current renderer cannot support the 
motion blur effect, the caption is greyed out to indicate this, although you can still 
use the slider to edit the scene definition, for instance to view with the screen saver
running full-screen on a Voodoo card.

Speed
Sets the rate of motion of the scene.    If "Infinite Speed" is set, this control will be 
greyed out.
Tip: If you want to accurately see how fast a scene would run in the screen saver, 
stop the tool window previews from animating (Control menu), and resize the 
window to around the same size as you've set for the screen saver.

Infinite Speed
For Still scenes, use "infinite" speed to make the scene jump to a completely new 
variation every time it is redrawn.    Can be used also for effects with Trails (see 
Weird/Eggshell).

Double-sided
By default the 3D meshes are back-face culled, as you cannot usually see the 
'inside' of the object.    However for flat objects such as Grid7200 or Land4 this 
makes the reverse side invisible.    Checking this option makes the renderer draw 
all the triangles even if they are facing away from the camera.    Note that the 
reverse side is only illuminated by the ambient light in the scene and not the main 
lights, and so appears dull.
This setting can also be used to good effect with transparency, or transparent 
textures such as Ikon.    However it should be switched off for regular closed-
surface meshes as it will increase rendering time a little for no visible difference.

Branches
Specifies the number of Branches the current Generator will use.    Will be greyed 
out if the current Generator does not have Branches.

Ribs
Specifies the number of Ribs the current Generator will use.    Will be greyed out if 
the current Generator does not have Ribs.



Shadows
Casts shadows of the informs from the light sources.    This can greatly enhance the
3D effect if used well, placing the 3D objects 'in' the scene, rather than 'on' it.      
Try selecting "Crystals/Sky Crystals", or "Titles/Demo Titles" and switch shadows 
on and off.
Use a simple lighting model (like "Default" or "Top Down") so the shadows appear
on the ground plane where you would expect.    Drawing shadows takes time, so 
they are best used with scenes with only a few objects.
The shadows setting is automatically switched off if you change to a black 
background where they would not be visible in any case.

Trails
When the trails effect is on, objects moving in the scene leave copies of themselves
behind, building up a sculpture over time.
The Trails effect is fully 3D ("Z-buffered"), so trails move in front of and behind 
themselves correctly.
See the scenes under "Trails" in the Scenes Menu for examples.
Note Trails images cannot be saved with "Save Image As...".

Inform Control
The controls allow you to set the informs which are used to build the scene.      
Some Generators only have one Inform (Other/Single) while others have up to 8 
(Spherical/Multiple Twisty Globe).
Clicking on << and >> moves between the informs.    One or more informs can 
have their mesh set to <none> to switch them off, allowing more variations from 
the same generator.
See General Interface Tips for more hints on using these controls.

Mesh
The dropdown listbox at the top left selects the basic 3D mesh that is used for this 
Inform (or "<none>").    Mesh complexity varies greatly, from 'tri' (4 vertices with 
one face) to 'Sphere9800' (9800 vertices and around 5000 faces).

Texture/Colour
Choose either a plain colour or a texture map for the object.    Some textures have 
areas which are translucent (when using 3D acceleration) or fully transparent.

Draw Style
Shapes can be drawn points, wire-frame, "unlit" (which turns them into a flat 
pattern), flat shaded (faceted), or Gouraud shaded (smoothed).



Note some objects are designed to stay faceted even with Gouraud shading, e.g. 
Dodec.

Texture Wrap Type
The texture can be applied to the mesh in a number of ways.    'Sphere Wrap' is a 
simple spherical projection.    Face Wrap tries to map the whole texture onto 
individual faces (Quad Face Wrap is a similar variant) - try these with the texture 
flow slider.
Chrome wrap applies the texture as if were reflected off the object - the effect is 
best when the texture and the scene's backdrop are based on the same image and 
there are several texture/backdrop pairs for this purpose (e.g. as in 
OADeluxe/Metal Niknak or Elastic/SoftMirror).
By using different textures and applying some texture flow, chrome wrap can also 
be used for a number of other interesting effects apart from the regular reflective 
look (OADeluxe/drifty flower, shinyest).

Scale
Controls the size of the inform.    This is the base size of the mesh, which may then 
be varied or animated by the generator as it runs.

Flow
This controls a 'texture mutation' effect, which makes the texture flow across the 
surface of a objects.    The effect is different for each wrap type, and can be varied 
in strength by the slider.

Transparency
This makes the object appear translucent.
Note that transparency is only visible with 3D hardware acceleration, or when 
saved to a BMP or the desktop wallpaper.    When using software rendering the 
'transparency' label is greyed, although you can still edit the scene parameter with 
the slider.

The Inform Preview Window
This shows the currently selected inform in more detail.

Elasticity Settings
Elasticity turns regular 3D solid objects all soft and gooey.    The mesh surface 
becomes a rubber-like sheet held together by elastic forces, while orbiting force-
fields push and pull it in all directions.
The effect is best on medium to high detail meshes such as Comtor through 
GeoSphere, although it needs plenty of CPU and 3D graphics horsepower to work 



really well; on a Pentium III the Elastic Mesh module will switch to fully Pentium 
III optimised code, which performs sets of three floating-point calculations in 
parallel, giving a significant performance boost.

Elasticity
When set to <none>, elasticity is disabled.    Choosing one of the other elasticity 
options sets how soft and deformable the mesh will become, how 'heavy' it is, and 
whether it settles quickly or stays bouncing around when no forces are applied.
Tip: Clicking on the Restart button resets the elastic mesh to its original shape.

Forcefield controls
The 'forcefield type' selects from a number of semi-random patterns of orbiting 
force fields.    Try selecting Elastic/ring thing or jfish and click "Show Fields" to 
visualise the forces.    The length of the axes show the radius of influence of each 
field, while the colour and centre arrows show whether it is currently repulsive 
(blue) or attractive (red) and how strong it is (the size of the arrows and brightness 
of the colour).

The forcefield generator moves the fields around the object and cycles their 
strength from strong to weak, even reversing between push and pull.    The Field 
Strength slider allows you to control the range and maximum/minimum field 
strengths.    If the mesh is set to 'Very Soft' then weaker forces should be used to 
avoid blowing it away altogether, whereas if the object is 'Stiff' it will pull back 
into shape much more quickly.    Some objects will break apart when the force is 
applied, although this can give an interesting effect in itself (Elastic/BoxBits).

When 're-light' is checked, the lighting is recalculated taking into account the 
object's deformation, otherwise the lighting is based on the original shape of the 
mesh.    Often there won't be much visible difference, and re-light should be left 
switched off, since it is expensive enough to slow the frame rate down noticably.

However if the object is being seriously warped then re-lighting can be a big 
improvement - the recalculated specular highlights on the ripples and bends will 
pick out much more detail and look more realistic.



The Status Bar

The Status Bar gives you information about what the Designer is currently doing.

The left-hand box shows the current activity, e.g. "Running" for when the scene is 
animating, or "Drawing" for when a complex scene is being rendered.

The centre area shows you the progress of lengthy activities.
The right-hand area shows either the frames-per-second speed of the animation, or 
for complex scenes, the number of seconds to render each frame.



General Interface Tips

· Double Click Scene
This randomises the position of the scene, like the Restart button in the Tool 
Window.

· Ctrl-Double Click Scene
This jumps to a random scene.

· Right Click List Boxes
You can right-click on list boxes (backdrops, shapes, textures) to randomise 
their setting.

· Cursor through List Boxes
On any of the list boxes (backdrops, shapes, textures),    use the up and down 
cursor keys to scroll through the contents of the list to browse possible choices.

· Wait for Redraw
When working on a complex scene, or using the Mutate Button, watch the 
Status Bar to see how the progress of the scene being drawn.    Each time you 
click the mouse or use the keyboard, the scene needs to start redrawing again 
from the beginning, so you need to leave the controls alone while waiting for a 
complex scene to display.

· Refreshing the Screen
If the display has not redrawn properly for some reason, right-click the Restart 
Button to refresh the window.

· Interrupting Saves
Lengthy operations, such as saving images to disk, can be interrupted by hitting 
the "Esc" key.
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Back-face Culling
The process of removing triangles which face away from the viewer in order to reduce mesh 
rendering time.



Generators
The modules in Organic Art which produce the characteristic forms and motion of the scenes.



Informs
The shapes that are used to build the scene.



Rendering
Essentially, "drawing" - the process of taking a the geometry of a 3D scene and drawing the 2D 
screen image it describes.



Resolution
The resolution of an image is the number of dots or "pixels" it contains.    A high resolution 
image looks very sharp, a low resolution image looks "blocky", as you can see the individual 
square pixels.



Colour Depth
The maximum number of colours in an image, or which your screen can display at once at its 
current settings.    8-bit (256-colour) modes are not supported, 16-bit or "high-colour" mode has 
up to 65536 colours, and is the recommended setting when using software rendering.    When 
using 3D acceleration, choose a 32-bit mode ("true colour") mode if the card supports it.    Note 
that some 3D cards provide 24-bit display modes, but often 3D acceleration will not work in this 
mode, only 2D drawing such as the Windows desktop.



Anti-aliasing
When rendering an image, blending colours together and smoothing out jagged edges to give 
better quality.    Can make lower resolution images look much better.
Achieved by calculating the image at a higher resolution than necessary, then blending together 
groups of pixels in the high-res image to make averaged pixel colours in the lower-res image.      
For example, a pixel on a black/white boundary would become grey, smoothing the edge.



Gamma Correction
Process of compensating for different brightness responses from different devices (e.g. different 
monitors).



Screen Buffers and Double Buffering
The technique of using an area of your computer's RAM to draw an image into, before 
transferring it to the screen.    "Double buffering" is using two such image stores, so one can be 
displayed while the other is drawing, then they can be quickly exchanged, giving smooth 
animation.



Z-buffer
A z-buffer goes along with an image of a 3D scene, and records the "depth" of each pixel in the 
scene.    This way, when a new object needs to be rendered into the scene, it can be correctly 
drawn in front of, behind, or intersecting with what is already there.



Mesh
A representation of an 3D shape, describing the coordinates of each of its vertices, and the way 
the vertices are joined up to form faces.    Can be visualised as a "wire frame".



Texture Map
A 2D bitmap image which is drawn on the surface of a 3D object.



Specular Highlights
The white spots of reflected light you see on shiny objects, particularly when their being lit by 
"point sources", like lightbulbs (rather than diffuse lighting).
In 3D graphics, specular highlights make objects look more realistic.



Real-time 3D
Graphics generated entirely "on-the-spot", for when you never know what the scene is going to 
do next (Organic Art, or fast 3D game environments).
Needs to run very fast, so an entire new image can be generated perhaps 30 times every second.
As opposed to "pre-rendered" graphics, which are generated over a matter of hours or days, then 
recorded; this means they are always the same, (and need to be played back from CD).



Stills Scenes
Complex scenes involving perhaps thousands of informs, which generate a new variation every 
few seconds, as opposed to continuously animating.



Mutate Button
This randomises each setting automatically.    You can control which settings are mutated by 
using the Mutate Options dialog box.    This is in the Options menu, or you can quickly access it 
by right-clicking on the button itself.
The Mutate Button can be a source of great variation, taking you to starting points you might 
never have discovered otherwise.



Trails
When the trails effect is on, objects moving in the scene leave copies of themselves behind, 
building up a sculpture over time.
The Trails effect is fully 3D ("Z-buffered"), so trails move in front of and behind themselves 
correctly.
See the scenes under "Trails" in the Scenes Menu for examples.
Note Trails images cannot be saved with "Save Image As...".



Branches
Some Generators are "branched".    Branching is a geometric operation used by Organic Art, 
which replicates each branch, i.e. strand of Ribs, and spins them round into a spherical pattern.



Ribs
The number of Informs in each section of a form.




